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5. When you close the capture file, you are asked to confirm the changes to the capture file.
See Confirming Capture File (CFA) Changes for more information.

23.5File Format for Merlin Files

FTS imports Merlin’s export files that have been exported with Merlin’s default settings.
These files should have an extension of ".csv".

It is possible with the Merlin software to hide or change a field’s format. If you do this
before exporting the Merlin file then FTS may have trouble importing the file.

If you are experiencing problems importing Merlin files, then check to make sure that no
fields were hidden and that the default field formats were being used, when the file was
exported from Merlin.
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24 Printing

24.1Printing from the Frame Display/HTML Export

The Frame Display Print dialog and the Frame Display HTML Export are very similar. This
topic discusses both dialogs.

The Frame Display Print dialog is directly below. The Frame Display HTML Export is
located midway in this discussion.

About Frame Display Print

The Frame Display Print feature provides the user with the option to print the entire
capture buffer or the current selection. When Print Preview is selected, the output displays
in a browser print preview window, where the user can select from the standard print
options. The output file format is in html, and uses the Microsoft Web Browser Control print
options for background colors and images (see below).
Print Background Colors Using Internet Explorer

1. Open the Tools menu on the browser menu bar
Select “Internet Options...” menu entry.

Click Advanced tab.

Check “Print background colors and images” under the Printing section

vt W

Click the Apply button, then click OK

Configure the Print File Range in the Frame Display Print Dialog

Selecting more than one frame in the Frame Display window defaults the radio button in the
Frame Display Print dialog to Selection and allows the user to choose the All radio button.
When only one frame is selected, the All radio button in the Frame Display Print dialog is
selected.

How to Print Frame Display Data

1. Select Print or Print Preview from the File menu on the Frame Display window to display
the Frame Display Print dialog. Select Print if you just want to print your data to your
default printer. Select Print Preview if you want access to printer options.

2. Choose to include the Summary Pane (check the box) in the print output. The summary
Pane appears at the beginning of the printed output in tabular format. If you select All
layers in the Detail Section, the Data Bytes option becomes available.

3. In the Detail Section, choose to exclude the decode from the Detail Pane in the Frame
Display, or include All Layers or Selected Layers Only. If you choose to include selected
layers, then select (click on and highlight) the layers from the list box. Click on selected
layers in the list to de-select, or click the Reset button to de-select all selected layers.
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CAUTION: Decode layers printout expanded regardless of the state of the Detail
Pane in the Frame Display at the time of the request to print. This can produce a
print output consisting of hundreds of pages or more. We recommend that you
use Print Preview to determine the number of pages in your print output prior to

printing.
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Select the range of frames to include All or Selection in the Frame Range section of the
Frame Display Print dialog.

Choosing All prints all of the frames in the capture file or buffer. If more than 1000 frames
in the Frame Range, All will be disabled. You can still select more than 1000 frames using
the Selection option, but when printing more than 1000 frames, there is the possibility that
Print will not work properly.

Choosing Selection prints only the frames you select in the Frame Display window.

Note: Selecting the Delete File deletes the temporary html file that was used
during printing..

4. Click the OK button.

If you chose Print Preview, the system displays your data in a browser print preview display
with options for printing such as page orientation and paper size. You can also use your
Printer Preferences dialog to make some of these selections. When printing your data, the
analyzer creates an html file and prints the path to the file at the bottom of the page. This
file can be opened in your browser, however, it may appear different than the printed
version.
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24.2Frame Display HTML Export

The Frame Display HTML Export feature provides the user with the option to export the
entire capture buffer to an .html file.

How to export display data to an .html file

1. Select HTML Export from the File menu on the Frame Display window to display the
Frame Display HTML Export.
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2. Choose to include the Summary Pane (check the box) in the .html output. If you select
All layers in the Detail Section, the Data Bytes option becomes available.

3. Inthe Detail Section, choose to exclude the decode from the Detail Pane in the Frame
Display, or include All Layers or Selected Layers Only. If you choose to include selected
layers, then select (click on and highlight) the layers from the list box. Click on selected
layers in the list to de-select, or click the Reset button to de-select all selected layers.

4. Select the range of frames to include All or Selection in the Frame Range section of the
dialog.

Choosing Selection includes only the frames you select in the Frame Display window.

Note: If the file size is too big, the Frame Range, All, will not be available. It will be grayed
out.

5. Click the OK button.

299



frontline

Debug Communications Fasier!s¥

The Save As dialog appears.
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6. Enter a name for the file you want to save.

Note: There is no need to choose a file type. The file is saved as a .htm.
7. Select Save

The file is saved as a .htm file in the file location you chose.

24.3Printing from the Event Display

About Event Display Print

The Event Display Print feature provides the user with the option to print either the entire
capture buffer or the current selection. When Print Preview is selected, the output displays
in a browser print preview window where the user can select from the standard print
options. The output file format is in html, and uses the Microsoft Web Browser Control print
options for background colors and images (see below).
Print Background Colors Using Internet Explorer

1. Open the Tools menu on the browser menu bar
Select “Internet Options...” menu entry.

Click Advanced tab.

Check “Print background colors and images” under the Printing section

vtk w N

Click the Apply button, then click OK
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The Event Display Print feature uses the current format of the Event Display as specified by
the user.

Note: See About Event Display for an explanation on formatting the Event Display prior to
initiating the print feature.

Configure the Print File Range in the Event Display Print Dialog

Selecting more than one event in the Event Display window defaults the radio button in the
Event Display Print dialog to Selection and allows the user to choose the All radio button.
When only one event is selected (can’t have None selected), the All radio button in the Event
Display Print dialog is selected.

How to Print Event Display Data to a Browser

1. Select Print or Print Preview from the File menu on the Event Display window to display
the Event Display Print dialog. Select Print if you just want to print your data to your
default printer. Select Print Preview if you want access to printer options.

2. Select the range of events to include from either All or Selection in the Event Range
section of the Event Display Print dialog. Choosing All prints all of the events in the
capture file or buffer. Choosing Selection prints only the selected events in the Event
Display window.

Note: In order to prevent a Print crash, you cannot select All if there are
more than 100,000 events in the capture buffer.

Note: See Configure the Print File Range in the Event Display Print Dialog above for an
explanation of these selections
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3. Click the OK button.

If you chose Print Preview, the system displays your data in a browser print preview display
with options for printing such as page orientation and paper size. You can also use your
Printer Preferences dialog to make some of these selections. When printing your data, the
analyzer creates an html file and prints the path to the file at the bottom of the page. This
file can be opened in your browser, however, it may appear different than the printed
version.
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24.4Print Preview

Print Preview gives a preview of how the data looks printed. You can scroll through the
pages and zoom in on the data to get a closer look. The line of buttons across the top of the
window controls the functions of the window.

To open the Print Preview window:
1. Choose Print Preview from the File menu in any window that supports printing.

2. Choose to include the Summary Pane (check the box) in the print output. The summary
Pane appears at the beginning of the printed output in tabular format. If you select All
layers in the Detail Section, the Data Bytes option becomes available.

3. In the Detail Section, choose to exclude the decode from the Detail Pane in the Frame
Display, or include All Layers or Selected Layers Only. If you choose to include selected
layers, then select (click on and highlight) the layers from the list box. Click on selected
layers in the list to de-select, or click the Reset button to de-select all selected layers.

CAUTION: Decode layers printout expanded regardless of the state of the Detail Pane in the
Frame Display at the time of the request to print. This can produce a print output consisting
of hundreds of pages or more. We recommend that you use Print Preview to determine the
number of pages in your print output prior to printing.
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4. Select the range of frames to include All or Selection in the Frame Range section of the
Frame Display Print dialog.

Choosing All prints all of the frames in the capture file or buffer. If there are more than

1000 frames in the capture file or buffer, All will not be available.

Choosing Selection prints only the selected frames in the Frame Display window.

Note: See Configure the Print File Range in the Frame Display Print Dialog above for an
explanation of these selections.
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Note: Selecting the Delete File deletes the temporary html file that was used
during printing..

5. Click the OK button.

You can print directly from the Print Preview window.

Next Page shows you how the next page in your data looks
Prev Page takes you back to the previous page.

Two Page changes the display to show two pages of data. When in the Two Page
display, the button reads One Page. Click on the One Page button to return to
viewing one page.

Zoom In and Zoom Out allow you to change the magnification of the pages. Click on
Zoom In to increase the magnification, and on Zoom Out to decrease the
magnification. When you have reached the limit in either direction, the buttons is
grayed out.

You can also zoom in and out by clicking on the page itself. When the cursor looks
like a magnifying glass, you can click on the page to increase the magnification.
When you have reached the top level of magnification, the cursor changes back to an
arrow. Click on the page to return to normal magnification.

Click on the Close button to return to the regular display.
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25 Exporting

25.1Export

You can dump the contents of the Summary pane on the Frame Display into a Comma
Separated File (CSV).

To access this feature:
1. Right click on the Summary Pane
2. Select the Export menu item
3. Enter a file name
4

Select Save

Another option to access quick export s :
1. Click on the File menu
2. Choose Export
3. Enter a file name
4

Select Save

25.2Export Filter Out

You can filter out data you don't want or need in your text file.

(This option is available only for serial data.) In the Filter Out box, choose which side to
filter out: the DTE data, the DCE data or neither side (don't filter any data.) For example, if
you choose the radio button for DTE data, the DTE data would be filtered out of your export
file and the file would contain only the DCE data.

You can also filter out Special Events (which is everything that is not a data byte, such as
control signal changes and Set I/0 events), Non-printable characters or both. If you choose
to filter out Special Events, your export file would contain only the data bytes. Filtering out
the non-printable characters means that your export file would contain only special events
and data bytes classified as printable. In ASCII, printable characters are those with hex
values between $20 and $7e.

25.3Exporting Event Display to a File

About Event Display Export
The Event Display Export feature provides the following options:
e Export either the entire capture buffer or the current selection

e Output file format as text, CSV, html, or bin.
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The Event Display Export feature uses the current format of the Event Display as specified
by the user.

Note: See About Event Display for an explanation on formatting the Event Display prior to
initiating the export feature.

Accessing the Event Display Export Dialog

Selecting Export Events... from the File menu in the Event Display brings up the following
dialog:
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Configure the Export File Range in the Event Display Export Dialog

e Selecting more than one event in the Event Display window defaults the radio
button in the Event Display Export dialog to Selection and allows the user to choose
the All radio button.

e When only one event is selected (something must be selected), the All radio button
in the Event Display Export dialog is selected by default.

e Side is used to determine whether you want to export data from a DCE/DTE,
Slave/Master, Host/Function device or both.

How to Export Event Display Data to a File

1. Select Export Events... from the File menu on the Event Display window to display the
Event Display Export dialog.

2. Enter a file path and name, or click the browser button to display the Windows Save As
dialog and navigate to the desired storage location.

3. Select a file type from the Save as type: drop-down List Menu on the Event Display
Export dialog.

4. Select from among the following file formats:

Text File (*.txt)
CSV File (*.csv)

HTML File (*.html)
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Select the range of events to include in the file from either All or Selection in the Event
Range section of the Event Display Export dialog.
Note: See Configure the Export File Range in the Event Display Export Dialog above for

an explanation of these selections.

Select a Side, either Host, Function, or Both

Click Save.

25.4Exporting Baudot

When exporting Baudot, you need to be able to determine the state of the shift character. In
a text export, the state of the shift bit can be determined by the data in the Character field.
When letters is active, the character field shows letters and vice versa.

25.5HTML Export

The Frame Display HTML Export feature provides the user with the option to export the
entire capture buffer to an .html file.

How to export display data to an .html file

1.

Select HTML Export from the File menu on the Frame Display window to display the

Frame Display HTML Export.
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Choose to include the Summary Pane (check the box) in the .html output. If you select
All layers in the Detail Section, the Data Bytes option becomes available.

In the Detail Section, choose to exclude the decode from the Detail Pane in the Frame
Display, or include All Layers or Selected Layers Only. If you choose to include selected
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layers, then select (click on and highlight) the layers from the list box. Click on selected
layers in the list to de-select, or click the Reset button to de-select all selected layers.

4. Select the range of frames to include All or Selection in the Frame Range section of the
dialog.
Choosing Selection includes only the frames you select in the Frame Display window.

Note: If the file size is too big, the Frame Range, All, will not be available. It will be grayed
out.

5. Click the OK button.

The Save As dialog appears.
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6. Enter a name for the file you want to save.

Note: There is not need to choose a file type. The file is saved as a .htm.

7. Select Save
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26 System Settings and Program Options

26.1System Settings

Open the System Settings window by choosing System Settings from the Options menu on
the Control window. To enable a setting, click in the box next to the setting to place a
checkmark in the box. To disable a setting, click in the box to remove the checkmark. When
viewing a capture file, settings related to data capture are grayed out.

System Settings E
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Capture Mode
e Series of files

This option lets you capture to a series of files. The size of each file is no larger than
the number given in File Size (in K),which has a maximum limit of approximately
176,000KB (1.7 GB) or 1/2 of the available hard disk space, whichever is smaller.
The name of each file is the name you give it in the Name box followed by the date,
time and a number. The date and time are when the series was opened. The number
increments with each file. This guarantees unique file names are created.

Set the maximum number of files in the series in the Maximum number of files box.
The next file starts when the currently open file is full. If you want to start a new file
on a periodic basis, check the box for Start new file after and put in the number of
hours after which a new file is started. Note that if the currently open file becomes
full before the time limit has been reached, a new file is opened immediately rather
than lose data.

Capturing stops if the maximum number of files has been used unless Wrap Files has
been checked. If Wrap Files has been checked the analyzer erases the oldest file in
the series and make a new file.

e Single File
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This option allows the analyzer to capture data to a file without prompting you for a
file name each time. The size of each file is not larger than the number given in File
Size (in K). The name of each file is the name you give it in the Name box followed by
the date and time. The date and time are when the series was opened.

Common Options
¢ Restart Capturing After Saving or Clearing Capture File

If the Automatically Restart feature is enabled, the analyzer restarts capture to the
file immediately after the file is closed.

Wrap File
When enabled, the analyzer wraps the file when it becomes full. The oldest events are
moved out of the file to make room for new events. Any events moved out of the file
are lost. When disabled, the analyzer stops capture when the file becomes full. Either
reset the file or close your capture file to continue.

o File Size (in K)
Enter the maximum size of the capture file, which is 176,000 KB, or 1/2 of the

available hard drive space, whichever is smaller. If you enter a number larger than
the maximum allowable size, the analyzer will display the allowable size.

¢ Default
Enter a name for the capture file in the Default text box. Each saved file will begin
with this name.

e Append Series Start/Date & File Number
Select this radio button to automatically append a start date (yyyy-mm-dd_hhmmss)
and file number (001) when capturing a series of files.

e Append File Start Date/Time
Select this radio button to automatically append a start date (yyyy-mm-dd_hhmmss)
when capturing a single file.

e Startup
Opens the Program Start up Options window. Start up options let you choose

whether to start data capture immediately on opening the analyzer.

e Advanced

Opens the Advanced System Options window. The Advanced Settings should only be
changed on advice of technical support.
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26.2System Settings - Disabled/Enabled Options

Some of the System Settings options are disabled depending upon the status of the data
capture session.

e As the default, all the options on the System Settings dialog are enabled.

¢ Once the user begins to capture data by selecting the Start Capture button, some of
the options on the System Settings dialog are disabled until the user stops data
capture and either saves or erases the captured data.

e The user can go into the Startup Options and Advanced System Options on the
System Settings dialog and make changes to the settings at any time.

26.3Bluetooth ComProbe Maintenance

The Bluetooth® ComProbe® Maintenance Utility is used to configure Bluetooth ComProbes
and to upgrade the firmware. Bluetooth ComProbes should be upgraded to the newest
firmware release to take advantage of new features and fixes.

Upgrading Your Bluetooth ComProbe

To start the Bluetooth ComProbe Maintenance Utility:

1. Open the FTS4BT desktop folder > Setup folder.

2. Double click the shortcut to the utility.
OR

1. From your Windows operating system click Start > Programs > FTS4BT [version#] >
Setup > Bluetooth ComProbe Maintenance Utility.

The main dialog appears.

2. Connect the ComProbe to the PC

3. Click on the Select Device button.
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To avoid mistakes, we recommended that only one ComProbe be connected at a time.
Also, it is very important that you do not remove any connections to the ComProbe
while the firmware update is in progress!

4. Select Yes.

Older ComProbes will display an error indicating the ComProbe is older and needs
replacing. Note that when you do this, the [Device Information], [Check Configuration] and
[Update Firmware] buttons should become available. [Update Firmware] will not be
accessible if you are using an older ComProbe®.

5. Select the Update Firmware button.

The utility will display a dialog titled “Select the firmware file to download”. There may be
more than one firmware file with extension “.dfu” in the directory. The version number of
the firmware will be in the name of the file.

6. Please select the version you want (typically you should choose the highest version
number).

7. Then press the Open button.

When the update is complete, a dialog appears confirming the download.

8. Press the OK button.

26.4Advanced System Options

These parameters affect fundamental aspects of the software, and it is unlikely that you
ever have to change them. If you do change them and need to return them to their original
values, the default value is listed in parentheses to the right of the value box.

Most technical support problems are not related to these parameters, and as changing them
could have serious consequences for the performance of the analyzer, we strongly
recommend contacting technical support before changing any of these parameters.

To access the Advanced System Options:

1. Go to the Control @ window.
2. Choose System Settings from the Options menu.

3. On the System Settings window, click the Advanced button.

e Driver Receive Buffer Size in Kbytes

This is the size of the buffer used by the driver to store incoming data. This value is
expressed in Kbytes.

¢ Driver Action Queue Size In Operating System Pages

This is the size of the buffer used by the driver to store data to be transmitted. This
value is expressed in operating system pages.
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e Frame Completion Timeout in Seconds

This is the number of seconds that the analyzer waits to receive data on a side while
in the midst of receiving a frame on that side.

If no data comes in on that side for longer than the specified number of seconds, an
"aborted frame" event is added to the Event Display and the analyzer resumes
decoding incoming data. This can occur when capturing interwoven data (DTE and
DCE) and one side stops transmitting in the middle of a frame.

Aborted frames (just like broken frames and regular frames) are decoded and
displayed in the Frame Display. If you experience aborted frames and suspect that
your framed data may have pauses in it that exceed the specified timeout time, then
you may want to increase that value.

The range for this value is from 0 to 999,999 seconds. Setting it to zero disables the
timeout feature.

Note: This option is disabled when capturing data over Ethernet networks.

26.5 Changing Default File Locations

The analyzer saves user files in specific locations by default. Capture files are placed in the
My Capture Files directory and configurations are put in My Configurations. These locations
are set at installation.

Follow the steps below to change the default locations.

@

1. Choose Directories from the Options menu on the Control
Locations window.

window to open the File

2. Select the default location you wish to change.
3. Click Modify.

4. Browse to a new location.

5. Click OK.

6. Click OK when finished.

Note: If a user sets the My Decoders directory such that it is up-directory from an
installation path, multiple instances of a personality entry may be detected, which causes a
failure when trying to launch FTS. For example, if an FTS product is installed at C:\FTS
Stuff\My Products\Frontline FTS4BT w.x.y.z, then "My Decoders" cannot be set to any of
the following:

o C:\
e C:\FTS Stuff
e C:\FTS Stuff\My Products

e C:\FTS Stuff\My Products\Frontline FTS4BT w.x.y.z
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e C:\FTS Stuff\My Products\Frontline FTS4BT w.x.y.zZ\App Data
e  C:\FTS Stuff\My Products\Frontline FTS4BT w.x.y.zZ\App Data\Decoders

e orto any directory that already exists under C:\FTS Stuff\My Products\Frontline
FTS4BT w.x.y.zZ\App Data\Decoders

Default Capture File Folder Checkbox

If the “Use Last Opened Folder for Capture Files” checkbox is checked, then the system
automatically changes the default location for saving capture files each time you open a file
from or save a file to a new location. For example, let's say the default location for saving
capture files is Drive A > Folder A. Now you select the “Use Last Opened Folder for
Capture Files” checkbox. The next time, however, you open a capture file from a different
location, Folder B > Removable Flash Drive. Now when you save the capture file, it will
be saved to Folder B > Removable Flash Drive. Also, all subsequent files will be saved to
that location. This remains true until you open a file from or save a file to a different
location.

There is one caveat to this scenario, however. Let's say you have selected "Use Last Opened
Folder for Capture Files" and opened a file from a location other than the default directory.
All subsequent capture files will be saved to that location. Suppose, however, the next time
you want to save a capture file, the new file location is not available because the directory
structure has changed: a folder has been moved, a drive has been reassigned, a flash drive
has been disconnected, etc. In the case of a "lost" directory structure, subsequent capture
files will be saved to the default location. FTS will always try to save a file to the folder
where the last file was opened from or saved to, if “Use Last Opened Folder for Capture
Files” is checked. If, however, the location is not accessible, files are saved to the default
directory that is set at installation.

If the checkbox is unchecked, then the system always defaults to the directory listed in the
File Locations dialog.

26.6Selecting Start Up Options

1. To open this window:

2. Choose System Settings from the Options menu on the Control @ window.
3. On the System Settings window, click the Start Up button.

4. Choose one of the options to determine if the analyzer starts data capture immediately
on starting up or not.

Don't start capturing immediately.

This is the default setting. The analyzer begins monitoring data but does not begin

capturing data until the Start Capture o icon on the Control, Event Display or Frame
Display windows is clicked.
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Start capturing to a file immediately.

When the analyzer starts up, it immediately opens a capture file and begin data capture to
it. This is the equivalent of clicking the Start Capture L icon. The file is given a name based
on the settings for capturing to a file or series of files in the System Settings window.

Start capturing immediately to the following file:

Enter a filename in the box below this option. When the analyzer starts up, it immediately
begins data capture to that file. If the file already exists, the data in it is overwritten.

Use this capture filter:

The drop down box lists all named filters. Select one that you want to use immediately on
start up.

26.7Names

The Names dialog is used to change the names of objects and events that appear in various
displays.

1. To open the Names dialog, choose Names from the Options menu on the Control
window. Changes to the Names are used throughout the program.

To change a name, click on the name given in the current column, and then click again to
modify the name (a slow double-click). To restore the default values, click the Defaults
button. The names used in the system fall into one of three general categories.

Because of variations associated with different types of communications, the Names dialog
may display all or only a subset of the following categories:

e Sides

The Sides section allows you to give each side on a network more descriptive names.
This is useful on network with more than one side.

e Errors

This section allows you to change the error names. The errors listed are appropriate
for the type of circuit/network you are monitoring.

e Signals

Signals refers to the six control signals used in RS-232 data communications, and
may not apply to the type of communications you are monitoring.

FTS4USB has four Control Signals: Pin 1, Pin 2, Pin 3, and Pin 4.
Default Labels and their Meaning
Label Control Signal

RTS Request to Send
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CTS Clear to Send

DSR Data Set Ready

DTR Data Terminal Ready
CD Carrier Detect

RI Ring Indicator

If you are used to different abbreviations for the same signals, you can change them
in this section. For example, if you normally refer to Carrier Detect as DCD, highlight
CD and type in DCD.

26.8Timestamping

26.8.1 Timestamping Options

The Timestamping Options window allows you to enable or disable timestamping, and
change the resolution of the timestamps for both capture and display purposes.
To open this window:

1. Choose System Settings from the Options menu on the Control window.

2. Click the Set Timestamp Format button.

OR

1. Click the Timestamping Options icon from either the Event Display or Statistics
window.

OR

1. Click the Timestamping Options icon from the Event Display window.
26.8.2 Enabling/Disabling Timestamping

1. Choose System Settings from the Options menu on the Control window, and click the
Timestamping Options button, or click the click the Timestamping Options icon

i ﬁ )
from either the Event Display or Statistics H] window.
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2. Check the Store Timestamps box to enable timestamping. Remove the check to disable
timestamping. If you disable timestamping, you are not able to do delta or rate
calculations.

26.8.3 Switching Between Relative and Absolute Time
With Timestamping you can choose to employ Relative Time or Absolute time.

1. Choose System Settings from the Options menu on the Control window, and click the

e

Timestamping Options button, or click the click the Timestamping Options icon ‘

from either the Event Display & or Statistics H] window.

2. Go to the Display Options section at the bottom of the window and find the Display
Relative Timestamps checkbox.

3. Check the box to switch the display to relative timestamps. Remove the check to return
to absolute timestamps.

Note: The options in this section affect only how the timestamps are displayed on the screen,
not how the timestamps are recorded in the capture file.

e Display Raw Timestamp Value shows the timestamp as the total time in hundred
nanoseconds from a specific point in time.

e Display Relative Timestamps shows the timestamp as the amount of time that has
passed since the first byte was captured. It works just like a stop watch in that
the timestamp for the first byte is 0:00:00.0000 and all subsequent timestamps
increment from there. The timestamp is recorded as the actual time, so you can flip
back and forth between relative and actual time as needed.

e Selecting both values displays the total time in nanoseconds from the start of the
capture as opposed to a specific point in time.

e Selecting neither value displays the actual chronological time.

When you select Relative Timestamp, you can set the number of digits to display using the
up or down arrows on the numeric list.

26.8.4 Changing the Timestamping Resolution

This option affects the resolution of the timestamp stored in the capture file. The default
timestamp is 10 milliseconds. This value is determined by the operating system and is the
smallest "normal” resolutions possible.
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It is also possible to use "high resolution" timestamping. High resolution timestamp values
are marked by an asterisk as high resolution in the drop down list. To change timestamping
resolutions:

1. Choose System Settings from the Options menu on the Control @ window, and click

the Timestamping Options button, or click the click the Timestamping Options icon

from either the Event Display & or Statistics H] window.

2. Go to the Capture Options section of the window.

3. Change the resolution listed in the Storage Resolution box. Note that if you change the
resolution, you need to exit the analyzer and restart in order for the change to take
effect.

26.8.5 Displaying Fractions of a Second

1. Choose System Settings from the Options menu on the Control @ window, and click

the Timestamping Options button, or click the click the Timestamping Options icon

from either the Event Display & or Statistics H] window.

2. Go to the Display Options section at the bottom of the window, and find the Number of
Digits to Display box.

3. Click on the arrows to change the number. You can display between 0 and 6 digits to the
right of the decimal point.

The options in this section affect only how the timestamps are displayed on the screen, not
the resolution used to capture the data.

26.8.6 Converting Timestamps

Serialtest for DOS uses a timebase of Pacific Standard Time during non daylight savings time
hours and Pacific Daylight Time during daylight savings time hours. The analyzer always
uses Greenwich Mean Time (also known as Universal Time Coordinates).

When importing a Serialtest for DOS file, the analyzer must determine if the file was
recorded during daylight savings time or not before converting the timestamps. Because the
rules for determining this can change, it is possible for the analyzer to convert the
timestamps incorrectly, resulting in timestamps that are off by one hour.

26.8.7 Performance Issues For High Resolution Timestamps

There are two things to be aware of when using high resolution timestamps. The first is that
high resolution timestamps take up more space in the capture file because more bits are
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required to store the timestamp. Also, more timestamps need to be stored than at normal
resolutions. The second issue is that using high resolution timestamping may affect
performance on slower machines

For example, if 10 bytes of data are captured in 10 milliseconds at a rate of 1 byte per
millisecond, and the timestamp resolution is 10 milliseconds, then only one timestamp
needs to be stored for the 10 bytes of data. If the resolution is 1 millisecond, then 10
timestamps need to be stored, one for each byte of data. If you have two capture files, both
of the same size, but one was captured using normal resolution timestamping and the other
using high resolution, the normal resolution file has more data events in it, because less
room is used to store timestamps.

You can increase the size of your capture file in the System Settings.
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27 Technical Information

27.1Contacting Technical Support

Technical support is available in several ways. The online help system provides answers to
many user related questions. Frontline's website has documentation on common problems,
as well as software upgrades and utilities to use with our products.

On the Web: http://www.fte.com/support/default.as

Email: tech support@fte.com

If you need to talk to a technical support representative, support is available between 9am
and 5pm, U.S. Eastern time, Monday through Friday. Technical support is not available on
U.S. national holidays.

Phone: +1 (434) 984-4500
Fax: +1 (434)984-4505

27.2Performance Notes

As a software-based product, the speed of your computer’s processor affects the analyzer’s

performance. Buffer overflow errors are an indicator that the analyzer is unable to keep up

with the data. The information below describes what happens to the data as it arrives, what
the error means, and how various aspects of the analyzer affect performance. Also included
are suggestions on how to improve performance.

The analyzer's driver takes data from the driver and counts each byte as they are put into
the driver’s buffer. The analyzer's driver tells the user interface that data is ready to be
processed. The analyzer takes the data from the driver’s buffer and puts the data into the
capture buffer.

Driver Buffer Overflows occur when the user interface does not retrieve frames from the
driver quickly enough. Buffer overflows are indicated in the Event Display window by a plus
sign within a circle. Clicking on the buffer overflow symbol displays how many frames have
been lost.

There are several things that you can do to try and solve this problem.

e Use capture filters to filter out data you don't need to see. Capture filters reduce the
amount of data processed by the analyzer. (Ethernet Only)

e C(lose all other programs that are doing work while the analyzer is running. Refrain
from doing searches in the Event Display window or other processor intensive
activities while the analyzer is capturing data.
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e Timestamping takes up processor time, primarily not in timestamping the data, but
in writing the timestamp to the file. Try turning off timestamping from the

Timestamping Options window.

e For Driver Buffer Overflows, change the size of the driver buffer. This value is
changed from the Advanced System Settings. Go to the Control Window and choose
System Settings from the Options menu. Click on the Advanced button. Find the
value Driver Receive Buffer Size in Operating System Pages. Take the number listed
there and double it.

e The analyzer’s number one priority is capturing data; updating windows is
secondary. However, updating windows still takes a certain amount of processor
time, and may cause the analyzer to lose data while the window is being updated.
Some windows require more processing time than others because the information
being displayed in them is constantly changing. Refrain from displaying data live in
the Event Display and Frame Display windows. The analyzer can capture data with
no windows other than the Control window open.

e Ifyou are still experiencing buffer overflows after trying all of the above options,
then you need to use a faster PC.

27.3Asynchronous Serial Performance Notes

As a software-based product, the speed of your computer’s processor affects FTS’s
performance. Overrun errors and buffer overflows are indicators that FTS is unable to keep
up with the data. The information below describes what happens to the data as it comes in
the port, what the two types of errors mean, and how various aspects of FTS affect
performance. Also included are suggestions on how to improve performance.

Data captured by the serial port first goes into the buffer of the UART chip of the serial port.
The UART generates an interrupt, which tells the FTS driver to check the port. The driver
takes the data from the UART and counts each byte as they are put into the driver’s own
buffer. The driver tells FTS that data is ready to be processed. FTS takes the data from the
driver’s buffer and puts the data into the capture buffer.

Overrun errors occur when the data in the buffer of the UART is not retrieved before new
data comes in. In this case, FTS knows that it has lost information, but it does not know how
much. FTS indicates overrun errors in the Event Display screen by marking a byte near the
overrun in red. You can search for overrun errors using the Find feature.

Driver buffer overflow errors occur when the data in the buffer of the driver is not retrieved
before new data comes in. Since the driver counts the bytes as it retrieves them from the
UART, it not only knows that it has lost data, it also knows how much. Buffer overflows are
indicated in the Event Display screen by a plus sign within a circle. Clicking on the buffer
overflow symbol shows how many events have been lost. The Statistics window is a good
place to check for buffer overflow errors.

Both overrun errors and buffer overflows indicate that data is coming in too quickly for FTS
to process. There are several things that you can do to try and solve this problem.
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e Inthe Hardware Settings window, select Use Windows Device Manager Settings. This
means that Windows does not generate an interrupt every time a byte comes in, but
rather waits until several bytes have accumulated in the UART buffer before telling
FTS to retrieve them. This increases performance at the cost of timestamp accuracy,
since all the bytes in a group have the same timestamp regardless of when they
actually arrived at the UART. Some control signal changes may also be lost.

e FTS’s number one priority is capturing data; updating windows is secondary.
However, updating windows still takes a certain amount of processor time, and may
cause FTS to lose data while the window is being updated. Some windows require
more processing time than others, because the information being displayed in them
is constantly changing. Refrain from displaying data live in the Event Display and
Frame Display windows. Try closing the Breakout Box and Statistics windows. FTS
can capture data with no windows other than the Control window open.

e Increase the value of the window refresh rate for any windows you have open while
capturing data. This decreases the frequency of window updates, leaving more time
for capturing data. Changing the refresh rate can be done from the Options screen
in each window.

e Ifyou suspect or know that your circuit has control signals that are changing very
rapidly, go to the Hardware Settings window and choose to Disable Control Signal
Interrupts. This prevents FTS from capturing control signal changes on an interrupt
basis, giving more time for capturing byte data. (You can use the counters in the
Breakout Box to help determine if a control signal is changing quickly.) FTS still
notes the state of the control signals whenever a byte is captured. You must restart
FTS for this change to take effect.

e C(lose all other programs that are working while FTS is running. Refrain from doing
searches in the Event Display window or other processor intensive activities while
FTS is capturing data.

e Timestamping takes up processor time, primarily not in timestamping the data, but
in writing the timestamp to the buffer or file. Try turning off timestamping from the
Timestamping Options window.

e Change the size of the driver buffer. This value is changed from the Advanced
System Settings. Go to the Control Window and choose System Settings from the
Options menu. Click on the Advanced button. Find the value labeled Driver Receive
Buffer Size in Operating System Pages. Take the value listed there and double it.

NOTE: This procedure might help buffer overflow errors, but does not
help overrun errors.

Slow down the speed of the communications circuit, if possible.

If you are still experiencing overruns and/or buffer overflows after trying all of the above
options, then you may need to use a faster PC.
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27.4Synchronous Serial Performance Notes

As a software-based product, the speed of your computer’s processor affects the analyzer’s
performance. Overrun errors and buffer overflows are indicators that the analyzer is unable
to keep up with the data. Underrun errors occur when the analyzer is unable to transmit
data quickly enough when transmitting synchronous data. The information below describes
what happens to the data as it comes in the ComProbe®, what the three types of errors
mean, and how various aspects of the analyzer affect performance. Also included are
suggestions on how to improve performance.

Data captured by the ComProbe first goes into the buffer of the Universal
Synchronous/Asynchronous Receiver Transmitter (USART) chip of the ComProbe. The
USART generates an interrupt, which tells the analyzer driver to check the ComProbe. The
driver takes the data from the USART and counts each byte as they are put into the driver’s
own buffer. The driver tells the analyzer that data is ready to be processed. The analyzer
takes the data from the driver’s buffer and puts the data into the capture buffer.

USART Overrun errors occur when the data in the buffer of the USART is not retrieved
before new data comes in. In this case, the analyzer knows that it has lost information but it
does not know how much. The analyzer indicates overrun errors in the Event Display
screen by marking a byte near the overrun in red. You can search for overrun errors using
the Find feature.

Driver buffer overflow errors occur when the data in the buffer of the driver is not retrieved
before new data comes in. Since the driver counts the bytes as it retrieves them from the
USART, it not only knows that it has lost data, it also knows how much. Buffer overflows are
indicated in the Event Display screen by a plus sign within a circle. Clicking on the buffer
overflow symbol shows how many events have been lost. The Statistics window is a good
place to check for buffer overflow errors.

Underrun errors occur only in synchronous source mode. If the analyzer cannot keep the
transmit buffer supplied with enough data, it sends non-data characters instead, and may
mark the next transmitted byte as an underrun error.

All three errors indicate that data is coming in or going out too quickly for the analyzer to
process. There are several things that you can do to solve this problem.

e The analyzer’s number one priority is capturing data; updating windows is
secondary. However, updating windows still takes a certain amount of processor
time, and may cause the analyzer to lose data while the window is being updated.
Some windows require more processing time than others, because the information
being displayed in them is constantly changing. Refrain from displaying data live in
the Event Display and Frame Display windows. Try closing the Breakout Box and
Statistics windows. The analyzer can capture data with no windows other than the
Control window open.

e Increase the value of the window refresh rate for any windows you have open while
capturing data. This decreases the frequency of window updates, leaving more time
for capturing data. Changing the refresh rate can be done from the Options screen in
each window.
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e Ifyou suspect or know that your circuit has control signals that are changing very
rapidly, go to the Hardware Settings window and choose to Disable Signal
Interrupts. This prevents the analyzer from capturing control signal changes on an
interrupt basis, giving more time for capturing byte data. (You can use the counters
in the Breakout Box to help determine if a control signal is changing quickly.) The
analyzer still notes the state of the control signals whenever a byte is captured. You
must restart the analyzer for this change to take effect.

e C(Close all other programs that are doing work while the analyzer is running. Refrain
from doing searches in the Event Display window or other processor intensive
activities while the analyzer is capturing data.

¢ Change the size of the driver buffer. This value is changed from the Advanced
System Settings. Go to the Control Window and choose System Settings from the
Options menu. Click on the Advanced button. Find the value labeled Driver Receive
Buffer Size in Operating System Pages. Take the value listed there and double it.
NOTE: This procedure might help buffer overflow errors, but does not help overrun
errors.

e Slow down the speed of the communications circuit, if possible.

If you are still experiencing overruns and/or buffer overflows after trying all of the above
options, then you may need to use a faster PC.

27.5Ethernet Performance Notes

As a software-based product, the speed of your computer’s processor affects FTS’s
performance. Receive overrun, frames missed and buffer overflow errors are indicators
that FTS is unable to keep up with the data. The information below describes what happens
to the data as it arrives at the network card, what the types of errors mean, and how various
aspects of FTS affect performance. Also included are suggestions on how to improve
performance.

Data captured by the network card first goes into the card's buffer. The card generates an
interrupt, which tells the NDIS driver to check the port. The FTS driver takes the data from
the NDIS driver and counts each byte as they are put into the FTS driver’s buffer. The FTS
driver tells the FTS user interface that data is ready to be processed. FTS takes the data
from the driver’s buffer and puts the data into the capture file.

Receive overruns occur when the frame buffer on the network card is not emptied by the
NDIS driver. Frames missed and no buffer errors occur when the FTS driver does not clear
out the NDIS driver buffer. In both of these situations, FTS knows that it has lost data, but
does not know how much.

Driver Buffer Overflows occur when the FTS user interface does not retrieve frames from
the FTS driver quickly enough. The Frames Lost counter on the Statistics window displays
the number of frames lost due to driver buffer overflows. Since the driver counts the
frames as it retrieves them from the NDIS driver, it not only knows that it has lost data, it
also knows how much. Buffer overflows are indicated in the Event Display window by a
plus sign within a circle. Clicking on the buffer overflow symbol displays how many frames
have been lost. The Statistics window is a good place to check for buffer overflow errors.
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All 3 types of errors indicate that data is coming in too quickly for FTS to process. There are
several things that you can do to try and solve this problem.

e Use capture filters to filter out data you don't need to see. Capture filters reduce the
amount of data processed by FTS.

e C(lose all other programs that are doing work while FTS is running. Refrain from
doing searches in the Event Display window or other processor intensive activities
while FTS is capturing data.

e Timestamping takes up processor time, primarily not in timestamping the data, but
in writing the timestamp to the buffer or file. Try turning off timestamping from the
Timestamping Options window.

e For Driver Buffer Overflows, change the size of the driver buffer. This value is
changed from the Advanced System Settings. Go to the Control Window and choose
System Settings from the Options menu. Click on the Advanced button. Find the
value Driver Receive Buffer Size in Operating System Pages. Take the number listed
there and double it.

e For Frames Missed and No Buffer errors, change the number of NDIS buffers. To do
this, choose Hardware Settings from the Options menu on the Control window, and
double the value listed in Number of NDIS buffers to use.

e FTS’s number one priority is capturing data; updating windows is secondary.
However, updating windows still takes a certain amount of processor time, and may
cause FTS to lose data while the window is being updated. Some windows require
more processing time than others because the information being displayed in them
is constantly changing. Refrain from displaying data live in the Event Display and
Frame Display windows. Try closing the Statistics windows. FTS can capture data
with no windows other than the Control window open.

e Ifyou are still experiencing receive overruns, frames missed errors and/or buffer
overflows after trying all of the above options, then you have to use a faster PC.

27.6BT Snoop File Format

Overview

The BT Snoop file format is suitable for storing Bluetooth® HCI traffic. It closely resembles
the snoop format, as documented in RFC 1761.

File Format

The snoop packet capture file is an array of octets structured as follows:
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File Header
Packet Record
Number 1

Packet Record
Mumber 2

9

Packet Record
Mumber M

The File Header is a fixed-length field containing general information about the packet file
and the format of the packet records it contains. One or more variable-length Packet Record
fields follow the File Header field. Each Packet Record field holds the data of one captured
packet.

File Header

The structure of the File Header is as follows:

Identification
Pattern

Version
Mumber = 1

Datalink Type

Identification Pattern:

A 64-bit (8 octet) pattern used to identify the file as a snoop packet capture file. The
Identification Pattern consists of the 8 hexadecimal octets:

62 74 73 6E 6F 6F 70 00
This is the ASCII string "btsnoop" followed by one null octets.
Version Number:

A 32-bit (4 octet) unsigned integer value representing the version of the packet
capture file being used. This document describes version number 1.

Datalink Type:

A 32-bit (4 octet) field identifying the type of datalink header used in the packet
records that follow. The datalink type codes are listed in the table below. Values O -
1000 are reserved, to maximize compatibility with the RFC1761 snoop version 2
format.

327



frontline

Debug Communications Fasier!s¥

Datalink Type Code

Resarved 0 - 1000
Un-ancapsulated HCI (H1) 100

HCI LART (H4) 1002

HCI BCSP 1003

HCI Senal (H5) 1004

Unassigned 1005 = 4294567 295

Packet Record Format

Each packet record holds a partial or complete copy of one packet as well as some
descriptive information about that packet. The packet may be truncated in order to limit the
amount of data to be stored in the packet file.

Each packet record holds 24 octets of descriptive information about the packet, followed by
the packet data, which is variable-length, and an optional pad field. The descriptive
information is structured as six 32-bit (4-octet) integer values.

The structure of the packet record is as follows:

Original Length

Included Length

Packet Flags

Cumulative Drops

Timestamp Microseconds

Packet Data

Original Length

A 32-bit unsigned integer representing the length in octets of the captured packet as
received via a network.

Included Length

A 32-bit unsigned integer representing the length of the Packet Data field. This is the
number of octets of the captured packet that are included in this packet record. If
the received packet was truncated, the Included Length field is less than the Original
Length field.

Packet Flags
Flags specific to this packet. Currently the following flags are defined:
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Bit no Definition

0 Direction flag. 0= Sent; 1 = Recawed

1 Command flag. 0= Data; 1 = CommandEvent

2=3 Resarved.

Bit 0 is the least significant bit of the 32-bit word.

Direction is relative to host / DTE. i.e. for Bluetooth controllers, Send is Host-
>Controller, Receive is Controller->Host.

Note: Some Datalink Types already encode some or all of this information within the
Packet Data. With these Datalink Types, these flags should be treated as
informational only, and the value in the Packet Data should take precedence.

Cumulative Drops

A 32-bit unsigned integer representing the number of packets that were lost by the
system that created the packet file between the first packet record in the file and
this one. Packets may be lost because of insufficient resources in the capturing
system, or for other reasons.

Note: some implementations lack the ability to count dropped packets. Those
implementations may set the cumulative drops value to zero.

Timestamp Microseconds

A 64-bit signed integer representing the time of packet arrival, in microseconds
since midnight, January 1st, 0 AD nominal Gregorian.

In order to avoid leap-day ambiguity in calculations, note that an equivalent epoch
may be used of midnight, January 1st 2000 AD, which is represented in this field as
0x00E03AB44A676000.

Packet Data

Variable-length field holding the packet that was captured, beginning with its
datalink header. The Datalink Type field of the file header can be used to determine
how to decode the datalink header. The length of the Packet Data field is given in the
Included Length field.

Note that the length of this field in not necessarily rounded to any particular multi-
octet boundary, as might otherwise be suggested by the diagram.

Data Format

All integer values are stored in "big-endian" order, with the high-order bits first.

27.7Changing Where the Search Lands

When doing a search in the analyzer, the byte or bytes matching the search criteria are
highlighted in the Event Display. The first selected byte appears on the third line of the
display.

To change the line on which the first selected byte appears:
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Open fts.ini (located in the C:\Program Files\Common Files\FTE)
Go to the [CVEventDisplay] section

Change the value for SelectionOffset.

W N

If you want the selection to land on the top line of the display, change the
SelectionOffset to 0 (zero).

27.8Progress Bars

The analyzer uses progress bars to indicate the progress of a number of different processes.
Some progress bars (such as the filtering progress bar) remain visible, while others are
hidden.

The title on the progress bar indicates the process underway.

27.9Event Numbering

This section talks about how events are numbered when they are first captured and how
this affects the display windows in the analyzer. The information in this section applies to
frame numbering as well.

When the analyzer captures an event, it gives the event a number. If the event is a data byte
event, it receives a byte number in addition to an event number. There are usually more
events than bytes, with the result is that a byte might be listed as Event 10 of 16 when
viewing all events, and Byte 8 of 11 when viewing only the data bytes.

The numbers assigned to events that are wrapped out of the buffer are not reassigned. In
other words, when event number 1 is wrapped out of the buffer, event number 2 is not
renumbered to event 1. This means that the first event in the buffer may be listed as event
11520 of 16334, because events 1-11519 have been wrapped out of the buffer. Since row
numbers refer to the event numbers, they work the same way. In the above example, the
first row would be listed as 2d00 (which is hex for 11520.)

The advantage of not renumbering events is that you can save a portion of a capture file,
send it to a colleague, and tell your colleague to look at a particular event. Since the events
are not renumbered, your colleague’s file use the same event numbers that your file does.

27.10 File Format for Merlin Files

FTS imports Merlin’s export files that have been exported with Merlin’s default settings.
These files should have an extension of ".csv".

It is possible with the Merlin software to hide or change a field’s format. If you do this
before exporting the Merlin file then FTS may have trouble importing the file.

If you are experiencing problems importing Merlin files, then check to make sure that no
fields were hidden and that the default field formats were being used, when the file was
exported from Merlin.
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27.11 Flag and Sync Character Subtleties

The chip used by the ComProbe® hides some details relating to HDLC/SDLC flags (hex 7e)
and the sync character in Bisync and Monosync.

In HDLC and SDLC, the analyzer does not know how many flag characters were actually
present between frames. The analyzer inserts a 7e at the start and end of each frame to
indicate that at least one flag was present on the link. What FTS shows is:

<7e><start-of-frame marker><data><crc><end-of-frame marker><7e><7e><start-of-frame
marker><data><etc.>

However, there may have been many flags between frames or just one, but the analyzer has
no way to know this.

In Bisync and Monosync, the chip hides the characters used as sync characters. The analyzer
displays at least two syncs in Bisync and one in Monosync to show that sync characters
were present, but the analyzer does not know how many syncs actually occurred. One result
of this is that the timestamps on the sync characters may not be correct since the analyzer
only knows that the sync characters occurred when data comes in.

27.12 Known Issues with the Source BD_ADDR Field

The data contained in the Source BD_ADDR field has the potential to be inaccurate.

A number of factors associated with wireless communication such as complex usage
scenarios, or dropped data packets due to poor RF reception contribute to incorrect
information periodically appearing in this field. Due to the nature of wireless
communication, it is not always possible for the analyzer, or any device, to determine the
BD_ADDR of the communicating devices on the network.

Users should keep in mind that the data contained in the Source BD_ADDR field should be
used as a guide and not an absolute.

27.13 Ring Indicator

The following information applies when operating the analyzer in Spy mode or Source DTE,
No FTS Cables mode. When using the cables supplied with the analyzer to capture or source
data, Ring Indicator (RI) is routed to a different pin which generates interrupts normally.

There is a special case involving Ring Indicator and computers with 8250 UARTs or UARTSs
from that family where the state of RI may not be captured accurately. Normally when a
control signal changes state from high to low or low to high, an interrupt is generated by the
UART, and the analyzer goes to see what has changed and record it. Ring Indicator works a
little differently. An interrupt is generated when RI changes from high to low, but not when
RI changes from low to high. If Ring Indicator changes from low to high, the analyzer does
not know that RI has changed state until another event occurs that generates an interrupt.
This is simply the way the UART works, and is not a deficiency in the analyzer software.
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To minimize the chance of missing a Ring Indicator change, the analyzer polls the UART
every millisecond to see if RI has changed. It is still possible for the analyzer to miss a Ring
Indicator change if RI and only RI changes state more than once per millisecond.

UARTS in the 8250 family include 8250s, 16450s, 16550s and 16550 variants. If you have
any questions about the behavior of your UART and Ring Indicator, please contact technical
support.

27.14 Padding of Short Frames

Ethernet requires that frames be a minimum of 60 bytes in length, not including the CRC. If
the frame is less than 60 bytes, the NIC pads it before putting it on the wire. Pad characters
are usually nulls (hex 00).

Frames transmitted by the PC running the analyzer are looped back by the NDIS driver so
the transmitting PC can see the frame. The loopback occurs before the NIC has added any
necessary padding to the end of the frame. The analyzer compensates for this by using the
sequence "Pad", repeated as many times as necessary, as a placeholder. The analyzer uses
only as many characters as needed to bring the frame up to the required 60 bytes, so you
may see partial "Pad"s or multiple "Pad"s. For example, you may see "PadPadPad", "PadPa"
"Pa", etc.

27.15 RS-232 Pin-outs

25-pin connector

Pin Name Abbreviation
1 Frame Ground FG

2 Transmit Data TxD

3 Receive Data RxD

4 Request To Send RTS

5 Clear to Send CTS

6 Data Set Ready DSR

7 Signal Ground GND

8 Carrier Detect CD or DCD
20 Data Terminal Read DTR

22 Ring Indicator RI
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9-pin connector

Pin Name Abbreviation
1 Carrier Detect CD or DCD
2 Receive Data RxD

3 Transmit Data TxD

4 Data Terminal Ready DTR

5 Signal Ground GND

6 Data Set Ready DSR

7 Request To Send RTS

8 Clear To Send CTS

9 Ring Indicator RI

27.16 CRC!

When NDIS receives a frame, it checks that the CRC is good and then discards it before
passing the frame up to the next higher layer. The analyzer adds "CRC!" to the end of
Ethernet frames to compensate.

NDIS does not pass up frames with bad CRCs, so there is no way for the analyzer to capture
them. Some (but not all) NDIS drivers record the number of frames received with bad CRCs.
The number of CRC errors is shown in the Errors table on the Statistics window.

To manually determine the CRC for a frame, use the CRC function on the Event Display.

27.17 BPF Copyright Notice

This copyright applies to code used in the filter feature. Filtering functionality in FTS is
based on Berkeley Packet Filtering (BPF), which is implemented in the UNIX program
tcpdump.

Copyright (c) 1990, 1991, 1992, 1993, 1994, 1995, 1996, 1997

The Regents of the University of California. All rights reserved.

This code is derived from the Stanford/CMU enet packet filter, (net/enet.c) distributed as
part of 4.3BSD, and code contributed to Berkeley by Steven McCanne and Van Jacobson both
of Lawrence Berkeley Laboratory.
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Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list
of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

All advertising materials mentioning features or use of this software must display
the following acknowledgement: This product includes software developed by the
University of California, Berkeley and its contributors.

Neither the name of the University nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS “AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

27.18 Useful Character Tables

27.18.1 ASCII Codes

hex| ®0 | x1 | 2 | x3 | xd | =5 | o6 | 27 [ xB [ 9 | zA | 2B [ xC | xD | xE | »F
Ox | MULISOH| STX| ETX |ECT|ENQIACK|BEL| BE | HT | LF | VT [ FF | CR | S0 | 3

1x |DLE |DC1|DC2| DC3 | DCA |NAKISYN| ETB |CAN| EM | SUB|ESC| FS | GS | RS [ US
AN - #%|%] & ' { ] B + ) - !

x| 0 1 2134|567 ([8]89 ; £ | = > ?

@ |A|B|C|D[EJF|G|[H|T|J[K|[L|[M[N]OD

Sx P Q R S T 0] Vol w [ X T Fi [ \ ] -

Bx ) E b c d 8 f g | h 1 ] k I m| n | o

xl p q r ] t i ¥ | w | x ¥ z { | 1 ~ |DEL
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27.18.2 Baudot Codes

[DEC | HEX | LETIERS | FIGURES |

0 | 00 |BLANK (NUL BLANK MNUL)

1 | o E 3

FIE LF LF

3 | @ A :

4 |04 SP SP

5 05 g BEL

6 | 06 [ B

7 | w7 1] 7

8 | o8 CR CR

g | D s

10 | 0A R [

i1 [ 08 J :

12 | 0C N ,

13 | 0D F 1

14 | OE [ :

15 | oF K {

16 | 10 T 5

17 | 11 I :

18 | 12 L ]

19 | 13 W 2

| 20 [ 14 H #

31 | 15 Y &

2 | 1. P 0

=l EE Q 1

24 | 18 0 g

25 | 19 B 7

% | 1A G &

27 | 18 | FicurRES | FIGURES

[ 28 | 1€ M

2 | 1D X ]

W | 1E W :

31 | IF | LETTERS | LETTERS
27.18.3 EBCDIC Codes

hew] =0 | x1 | x2 | %3 | x4 | 5 | b | x7 | »8 | #9 | «A | «B | xC | %0 | *E | *F
Ox [MUL|SOH[ST[ET®| PF | HT | LC [DEL Isk wT [ FF [CcR [ S0 [ S
1x |DLE|DC1|DC2| TM [RES| NL | BS | IL_|CAN|EM | CC |CUT|IFS [1GS | IRS [ IUS |
2« | DE [S0S] FE BYP| LF |ETB|ESC EEE [EnG]ACK][BEL
3x SyH| PN RSl uC|EOT FIE T SUB
4x | 5P <l |+

£x | & | 5| " 1 R A
Bx | - | / HEES > | 7
¥ : # @ " |1=1"
Bx [ b [+ [ f Q h i

Sx i k | m o p | g [

Ax ~ 5 [ u w | x | ¥ z |

Bx 1

cxl [ [AlBIC|D|E|JF|G[H]1

(D= } [J[K|L|M|N|JO|P|G|R

Ex| sltTlulvIiwlalylz

Felo |1l 2]3 25|67 8a]ls

Debug Communications Faster! su
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27.18.4 Communication Control Characters

Listed below in alphabetical order are the expanded text meanings for common ANSI
communication control characters, and two-character system abbreviation for each one.
Some abbreviations have forward slash characters between the two letters. This is to
differentiate the abbreviations for a control character from a hex number. For example, the
abbreviation for Form Feed is listed as F/F, to differentiate it from the hex number FF.

Abbreviation Control Text
Character

AK ACK Acknowledge

BL BEL Bell

BS BS Backspace

CN CAN Cancel

CR CR Carriage
Return

D/1-4 DC1-4 Device
Control 1-4

D/E DEL Delete

DL DLE Data Link
Escape

EM EM End of
Medium

EQ ENQ Enquiry

ET EOT End of
Transmission

E/C ESC Escape

E/B ETB End of
Transmission
Block

EX ETX End of Text

F/F FF Form Feed

FS FS File
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Separator

GS GS Group
Separator

HT HT Horizontal
Tabulation

LF LF Line Feed

NK NAK Negative
Acknowledge

NU NUL Null

RS RS Record
Separator

SI SI Shift In

SO SO Shift Out

SH SOH Start of
Heading

SX STX Start of Text

SB SUB Substitute

SY SYN Synchronous
Idle

usS usS Unit
Separator

VT VT Vertical
Tabulation

27.19 The Serial Driver

27.19.1 The FTS Serial Driver

FTS uses custom versions of the standard Windows serial drivers in order to capture data.
These drivers are usually installed during the routine product installation. However, if you
need to install the serial driver after FTS has already been installed, please refer to the
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instructions available in the Setup folder installed under Start | Programs | [Product Name
and version #] | Setup | How to Install the FTS Serial Driver.

27.20 Frame Decoder

Frame Decoder is for the development of add-on components to extend the functionality of
your FTS protocol analyzer. Those add-on components are generally used to decode
existing or custom protocols. The core of each such “decoder” is a program that defines how
the protocol data are to be broken up into fields and displayed in the Frame Display window
of the analyzer software. The DecoderScript Manual provides instruction on how to create
custom decoders and use them just like any of the decoders supplied with the protocol
analyzer. You can also apply this knowledge to modify decoders supplied with the protocol
analyzer.

For more information about Frame Decoder, consult the DecoderScript Manual located in
the desktop folder under Optional Components, or simply select Start [ Programs | Frontline
[Product Name and Version Number] | Optional Components | DecoderScript Manual.
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A2DP Decoder Parameters - 18
About Display Filters - 267
About Statistics - 137
Absolute Time - 321
Absolute Timestamp Search - 261
Active Devices - 150
Active Devices Grid - 151
Active Devices Grid Buttons - 151
Add a New or Save an Existing Template - 47
Add/Edit an Alias for a Node in Network View - 218
Adding a New Predefined Stack - 91
Adding Comments To A Capture File - 295, 298
Advanced Display Filtering Techniques - 271
Apply Capture Filters - 59, 267, 268, 274, 275, 276,
277,278, 279, 285, 286
Apply Display Filters - 267, 268, 269, 270, 271, 272,
273,274
ASCII - 102, 258
character set - 338
removing the numbers on the Event Display - 102
searching for ASCII strings - 258
transmitting in - 173
viewing data in - 102
ASCII Codes - 338
ASCII Pane - 117
Asynchronous Serial Performance Notes - 326
Audio Extraction - 242
Automatically Request Missing Decoding Information
- 94
Auto-Sizing Column Widths - 114
Auto-traversal - 91
AVDTP - 20, 21, 22, 23, 24
AVDTP Override Decode Information - 24
AVDTP Parameter - 21, 22
Add - 21
Delete - 22
AVDTP Parameter Template - 20, 22, 23
Add - 22
Apply - 20
Delete - 23
Average Throughput Indicators
Average_Throughput_Indicators - 201

B

Backward Compatibility - 171
Bar Charts - 138
Baudot - 102, 173, 311
Baudot Codes - 339
BD_ADDR - 335
Berkeley Packet Filtering - 277
Binary - 257, 259
Binary Pane - 118
Bookmarks - 265, 266, 288
Boolean - 269, 273
BPF - 277
Breakout Box - 130, 131
Breakout Box Options - 131
Buffer - 292
Buffer Tabs - 137
Busy Tokens - 158
Byte - 118, 334
Byte Count - 160
Bytes Per Second Table - 140

C

Calculating Data Rates and Delta Times - 101
Capture Buffer - 292
Capture File - 174, 292, 294, 295, 298
changing default location of - 317
loading - 297
removing framing markers - 93
saving - 292
transmitting - 174
Capture Filters - 267, 274, 275, 276, 278, 279, 285,
286
Capturing - 54
ControlNet Data - 54
CFA file - 294, 295, 298
Changing Default File Locations - 317
Character - 257, 258
Character Pane - 117
Character Set - 102, 338, 339
Character Strings in Searching - 258
Characters Per Second Table - 138
Coexistence View Introduction - 181
Coexistence button bar - 186
Color of Data Bytes - 118
Colors - 119

339



Column Width - 114
Comma Separated File - 309
Compound Display Filters - 269
Compound Ethernet Capture Filters - 278
Confirm CFA Changes - 294
Context For Decoding - 94
Control Characters - 173, 259
Control Signals - 131, 133, 134, 136, 319
Control Window - 5, 10

Configuration Information - 5

Control Window Toolbar - 3
ControlNet - 54, 59

ControlNet I/O Settings - 55
ControlNet 1784-U2CN Hardware Settings - 62
ControlNet 1784-U2CN 1/0O Settings - 63
Conversation Capture Filters - 276
Conversation Filters - 270
Copying Statistics - 138
CSV Files - 309
Custom Protocol Stack - 91
Custom Stack - 91
Customizing Fields in the Summary Pane - 114
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D

Dashboard
Dashboard - Define Authorized IP Addresses - 238
Dashboard - Show IP Addresses Seen - 239
Network View Dashboard - 231

Data - 101, 291, 292

Data Byte Color Denotation - 118

Data Extraction - 243

Data Rates - 101

Decode Pane - 116

Decodes - 94, 107, 116, 253

Default File Locations - 317

Delete a Template - 47

Deleting Display Filters - 271

Delta Times - 101

Device Token Rotations - 158

Devices Grid - 150

Difference Between Ethernet Capture Filters - 267

Direction - 270

Directories - 317

Disabling - 320

Discontinuities - 203

Display Conversation Information in Network View -
217

Display Entire Buffer - 134

Display Filters - 267, 272, 273, 274

Display Options - 154, 322

Dots - 115

Driver - 341

Duplicate View - 99, 112
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Easy Protocol Filtering - 119, 286
EBCDIC - 102

EBCDIC Codes - 339
Enabling/Disabling Timestamping - 320
Errors - 119, 121, 125, 288, 289, 319
Ethernet Capture Filter - 274, 275, 277, 278, 279, 285,

286
Event Display - 112, 304, 309

Event Display Export - 309

Event Display Print - 304

Event Numbering - 334

Event Pane - 118
Exclude - 268
Exclude Radio Buttons - 268
Expand All/Collapse All - 116
Expand Decode Pane - 113
Export

Export Baudot - 311

Export Events... - 309

Export Filter Out - 309

Export WAV File - 242

F

Field Width - 114

File - 174, 278, 286, 291, 292, 297

File Format Required for Merlin Capture Files - 299,
334

File Locations - 317

Filtering - 119, 218, 276, 286, 289

Filters - 119, 121, 124, 125, 218, 267, 268, 269, 270,
271,272, 273, 274, 275, 276, 277, 278, 279, 285,
286, 288, 289

Find - 253, 257, 258, 259, 260, 261, 262, 263

Flow Control - 177

Font Size - 105

Fractions Of A Second - 322

Frame Display - 107, 111, 112, 113, 114, 115, 116,
117,118, 119
Frame Display Status Bar - 111
Frame Display Window - 107
Frame Symbols - 115

Frame Display - Right Click Filtering - 116, 121

Frames Per Second Table - 140

Freeze - 101

FTS Serial Driver - 341

FTS4USB Hardware Settings - 11

FTS4USB I/0 Settings - 14
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G M
Graph Refresh Rate - 139 MAC Address Filter - 276
Graphs - 138, 139 Menus - 4
Green Dots in Summary Pane - 115 Merlin Files - 299, 334
Minimizing - 10
Missing Decode Information - 24, 36
H Mixed Channel/Sides - 103
Mixed Sides Mode - 103
Hardware Settings - 11 Modem Lead Names - 319
Hex - 259 Modem Leads - 133
Hexadecimal - 117 Modify Capture Filters - 275, 278, 279
Hiding - 124 Modify Display Filters - 273, 274
Hiding Display Filters - 271, 272 Multiple Event Displays - 99
Hiding Layers - 124 Multiple Frame Displays - 112
High Resolution Timestamping - 321, 322
N
I
Named Filters - 278, 289
1/0O Settings - 55 Names - 319
Include - 268 NetDecoder 1784-U2DN 10 Settings Start Triggers - 74
Include/Exclude - 268 Network Bytes Sent - 159
Information Screen - 90 Network Bytes Sent Totals - 160
IP Address Network View Dashboard - 231

Filter - 276 Define Authorized IP Addresses - 238
Show IP Addresses Seen - 239

Network View Introduction - 215

L Network View Technical Notes - 226

New Snapshot - 134

Node Capture Filters - 276

Node Database - 223

Node Filters - 218, 270

L2CAP - 26, 27, 28, 29
L2CAP Parameter - 27, 28

Add - 27
Delete - 28 Nonprintables - 309
L2CAP Parameter Template - 26, 28, 29 Notes - 295, 298
Add - 28 Numbers - 334
Delete - 29
Layer - 124
Layer Colors - 119 o
Live Update - 101
Load Filter File - 286 Octets Per Second Table - 143
Low Energy Timeline Offset - 277
Average Throughput Indicators - 211 Offset Ethernet Capture Filters - 277
Button Bar/Legend - 206 Open - 99, 286
Discontinuities - 214 Open Capture File - 297
Legend - 214 Options - 131, 136, 154, 180, 318, 320
Navigating and Selecting Data - 205 Override Decode Information - 24, 36
Once Second Throughput Indicators - 211 Overriding Frame Information - 94
Throughput Display - 211
Throughput Graph - 213
Timeline Menu Bar - 207 p
Timeline Packet Depiction - 204
Visual Elements - 208 Packet Error Rate - 147
Zooming - 210 Packet Timeline - 195, 203
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Packet Timeline Menu Bar - 196
Packet_Timeline_Introduction - 191
Packet_Timeline_Visual_Elements - 198
Panes - 113
Parameter Template - 38, 40, 41
Parameters - 38
Pattern - 173, 257, 277
Pattern Ethernet Capture Filters - 277
Percentages - 139
Performance Issues For High Resolution Timestamps -
322
Performance Notes - 325, 326, 329
Physical Errors - 119
Pie Charts - 138
Predefined - 276
Predefined Ethernet Capture Filters - 276
Printing - 139, 304
Printing from the Frame Display - 301
Progress Bars - 334
Protocol
Protocol Layer Colors - 119
Protocol List - 10
Protocol Navigator - 121
Protocol Stack - 91, 92
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Delete - 33
RFCOMM Parameter Template - 32, 34, 35
Add - 34
Apply - 32
Delete - 35
ROC - 38, 39, 40, 41
ROC Parameter - 39, 40
Delete - 39
Edit - 40
ROC Parameter Template - 38, 40, 41
Add - 40
Delete - 41

Q

Quick Export - 309
Quick Filtering - 121, 288

R

Radix - 117
Red Frame Numbers - 119
Relative Time - 260, 321
Relative Timestamp Search - 262
Remove
Bookmarks - 265
Columns - 114
Filters - 271, 272, 275
Framing Markers - 93
Renaming - 274
Reset Panes - 113
Resetable Tab - 137
Resolution - 321
Resolving DNS Names in Network View - 224
Revealing Display Filters - 272
Revealing Layers - 124
Revealing Protocol Layers - 124
RFCOMM - 32, 33, 34, 35, 36
RFCOMM Missing Decode Information - 36
RFCOMM Override Decode Information - 36
RFCOMM Parameter - 33
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Save - 268, 285, 291, 292
Save As - 291
Saving - 285, 291, 292
Display Filter - 268
Saving the Capture File using File > Save or the Save
icon - 291
Search - 253, 257, 258, 259, 260, 261, 262, 263, 266
binary value - 257
bookmarks - 266
character string - 257
control characters - 259
entering character strings - 258
hex or binary characters - 259
hex pattern - 257
pattern - 257
strings in decodes - 253
timestamp - 260
wildcards - 257
Send - 173, 180
file - 174
string - 173
Serial Driver - 341
Set The Count For Top N Filters - 219
Sides - 319
Signal Display - 133, 134
Signal Display Options - 136
Signal Display Toolbar - 134
Sorting Frames - 112
Source BD_ADDR - 335
Source BD_ADDR Field - 335
Spy - 49
Spy Mode Settings - 49
Start Up Options - 318
Starting DH+ Statistics - 149
Statistics - 137
Statistics Graphs - 138
Strings - 173
Summary Layer Protocol - 119, 286
Summary Pane - 114, 115



Synchronization - 112

T

Template - 22, 23, 33
Templates - 20, 28, 29, 32, 34, 35, 41, 44, 45
The Network View Toolbar - 224
Throughput Displays
Throughput_Displays - 201
Throughput Graph - 202
Timestamp - 261, 262, 263, 321, 322
Timestamping - 262, 320, 322
Timestamping Options - 320
Timestamping Resolution - 321
Timestamps - 320, 322
Token - 158
Top Conversations Dialog - 165
Top Listeners - 169
Top Talkers - 152, 164
Transmit - 173, 174, 177, 180
Transmit Options - 180
Transmit Toolbar - 175
Transmit Window - 173
Transmitting - 174
Transmitting Frames - 174
Troubleshooting - 335

frontline

Debug Communications Faster!sv

USB ComProbe - 11, 14
USB HClI Internal Software Tap Data Source Dialog - 96
USB Parameter - 43, 44
Delete - 44
USB Parameter Template - 42, 44, 45
Add - 44
Delete - 45
USB URB Data Source Dialog - 11
User Defined Stacks - 92
Using BPF - 277
Using Named Filters - 289
Utilization Table - 141

v

Values - 139
Viewing Data Events - 101

u

Unframe - 93
Unframe Function - 93
Unframing - 93

USB - 42, 44, 45, 96

w

What To Do When The Correct Values Of Decoder
Parameters Are Unknown - 80

Wi-Fi Timeline
Channel Frequencies - 188
Channel Frequencies - 5 GHz Channels - 189

4

Zooming
Zooming - 200
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